Example name

Effect size
Analysis type
Level

Synopsis

Cannon | High Dose vs. Standard Dose Statins

Risk ratio
Basic
Basic

This analysis includes four studies where patients were randomized to receive either a standard dose or
a high dose of statins. Outcome was the proportion of patients with a cardiovascular event or death in

each group.

Cannon, C. P, Steinberg, B. A., Murphy, S. A., Mega, J. L., & Braunwald, E. (2006). Meta-analysis of
cardiovascular outcomes trials comparing intensive versus moderate statin therapy. J Am Coll Cardiol,

48(3), 438-445.

We use this example to show

e How to enter data from 2x2 tables

e How get a sense of the weight assigned to each study

e How to perform a sensitivity analysis

e How to choose between fixed-effect and random-effects models
e How to interpret statistics for effect size

e How to interpret statistics for heterogeneity
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The data for this exercise are located at

www.Common-Mistakes-in-Meta-Analysis.com

Navigate to the folder for the Canon analysis and download the following
e This PDF

e The data for this analysis in an Excel format

e The data for this analysis in CMA format

To download a trial of CMA go to

www.Meta-Analysis.com

To open a CMA file > Open file from within CMA

You cannot open the file by clicking on it

© www.Meta-Analysis.com Cannon
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If you would like to start with a blank file and enter the data, proceed with the next page

If you would like to simply open the file with the Cannon data, proceed with this page

e Start the CMA program

e C(Click the icon for the Opening Wizard
e Click More Files

e Locate the file Cannon.CMA

e Proceed with the analysis on Page 21

Comprohenswc meta analysis - [Data]

File Edit Format Vief Insert Iden Tools Computational options Analyses Help
Run analyses + % [ | b BB E'=E R -V 2+ VD
A B hh) D G H | J K £ M N
1 |
2
3,
4
5 B3 Welcome - X
B
7 =
g ‘What would you like to do?
9
10
" " Run the tutorial
12
13 " Start a blank spreadsheet
14 " Start a new spreadsheet using a template
15
16!
17 " Import data from another program
18
13 ~ A
20 & More files ...
21 =] - p $ 0 akes we examp
22 =] C:\Users\Biost\OneDrive\DesktopiDEB change meta-analysis_AL
23 B C:\Users\Biost\Dropbox'$ Common mistakes web\aDHD.cma
g; B C:\Users\Biost\Dropbox'$ BMJ\Restrictive vs Liberal.cma
2% B C:A\Users\Biost\Dropbox\$ BMJ\Atrial fibrillation and risks of cardioy
27/ B C:\Users\Biost\Dropbox\$ BMJAH hour presentation.cma
28 B C:\Users\Biost\Dropbox\$ BMJ\Efficacy and safety of dual SGLT -
) B C:\Users\Biost\Dropbox\$ BMJ\&ntidepressant efficacy of agomel: v
30
kil
32 [V Show this dislog when | start the program
33
e Close | ok |
35
36
37
38
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To create a new file from scratch, start here.

Start the program

e Select the option [Start a blank spreadsheet]

e Click [OK]

E Comprehensive meta analysis - [Data]

File Edit Format View Insert Identify Tools Computational options Analyses Help

Run analyses + %z [ E—:EE‘§| %|E|%§

-

= E[Suwn -V 2+ v HE D

F ‘ G | H | | | J | K ‘ L | ] ‘ N

© www.Meta-Analysis.com

E Welcome |

Wwhat would you like to do?

Rl =T |

& [Stant a biank spreadshiest
Cia i -

" Open an existing file

" Import data from anather program

¥ Shaow this dialog when | start the program

o [[ 0K |

Cannon
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Click Insert > Column for > Study names

E‘ Comprehensive meta analysis - [Data]

File Edit Format VNiew | Insert Identify Tools Computational options Analyses Help
run anayses > % [ Mm "o+ 8@
2 Subgroups within study
A B plenk column Comparison names H ! d K L M
[ia Copy of selected column
_1—| Outcome names
2 *— Blank row . .
— Time point names
3 *= Blank rows
4 Copy of selected row(s) 3 Effect size data
| 5] — Moderator variable
& Y= Study r
|7
|8
9
The screen should look like this
Comprehensive meta analysis - [Data]
File Edit Format View Insert Identify Tools Computational options Analyses Help
R = LI N R an o)
Study name B C ‘ [} ‘ E ‘ F G H | ‘ J ‘ K ‘ L | I ‘ M
L
| =
3
4
5
5
7
| 8]
g
Click Insert > Column for > Effect size data
E‘ Comprehensive meta analysis - [Data]
File Edit Format Eiew|1nsert Identify Tools Computational options Analyses Help
e > % 0 it TR 5oy vomes eI
2 Subgroups within study
Study name | EEfaeimn Comba H ‘ I ‘ J ‘ K ‘ L ‘ M ‘ N ‘
Copy of selected column omparison names
1 Outcome names
2 e Time point names
3 *= Blank rows P
|4 Copy of selected row(s) %m
| 5| — Moderator variable
3 Y= Study T
7
g
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The program displays this wizard

SeleCt [ShOW a|| 100 formats] f B Insert columns for effect size data &

Click [Next]

Welcome

If you have alieady computed the effect size [such as the
standardized mean difference or the Log odds ratia) for
each study, you may enter this information directly.

Qr, pou may provide summary data [such as the number of
events of the means and standard deviations). and the
program will compute the effect size automatically

Use this wizard ta specify the type of data you plan to
enter, and the program will create the required colurmng.

The program allows vou to enter effect size data in more
than one format. You will create one set of effect size
columns now, and may add additional sets at any time.

" Show commaon formats only
& Show all 100 formats

Select [Comparison of two groups...] B Insert columns for effect size data 2o

Click [Next]

Types of studies included

On this panel, select the type of studies to be included in
thiz meta analysiz. This controls the tupes of data entry
options to be displayed on the nexst panel.

If unzure, select the first option, which is appropriate for
most analyzes. You will be able to return to this panel and
change the selection.

Comparizon of twao groups, time-points,
of exposures [includes correlations]

o)

Estimate of means, propartions of rates
in one aroup at one time-point

Generic point estimates

e B

Generic paint estimates, log scale

Drill down to ( B Insert columns for effect size data @

Click on the icons to zelect the data entry format

»

0 Twa graups or correlation

Dichotomous (number of events) ({2 Dishetomous {number of svents

. [:Q| Unmatched groups, prospective [e.0.. controlled brisls, cohort studies]
Unmatched groups, prospective ... HEvents and sample size in s5ch group ]
. . =] Noneeverts and sample size in each group L
EVentS and Sample size In eaCh group @ Events and non-events in each group 3
@ Event rate and zample size in each group
@ Chi-zquared and tatal sample size
Q Matched groups, prospective (2.0., crossover brials or pre-post designs]
Q Unmatched groups, retrospective [e.q., case contral studies)
Q Computed effect sizes
Q Continuous [means)
Q Carrelation
Q Fates [events by person years)
@ Survival [time to event)

© www.Meta-Analysis.com Cannon — 6 —
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The program displays this wizard

Enter the following labels into the wizard

e First group > High

e Second group > Standard

o Name for events > Event

e Name for non-events > Ok

Click [Ok] and the program will copy the names into the grid

@ Comprehensive meta analysis - [C:\Users\Biostat\Dropbox\Workshops Three-Day\Cannon\cannon.cma]

Run analyses —+ S

&

File Edit Format View Insert Identify Tools Computational options Analyses Help

W00 +,0
+.0 G0 ]

o>+ AR ®

Study name

1| Prove it =

High High Standard
Event | TotalMN Evvent

Standard
Tatal W

Ay 205 2265
3| TNT 334 4335
4| Ideal 11 4433

© www.Meta-Analysis.com

235
418
463

BRG]
2232
5006
4443

—

Riisk ratio

0.840
0.860
0.8m
0.830

Log _risk
1atia
0174
0151
0.222
0117

StdEnr Wariance J

0103 ooz
0.0 0003
0.071 0.005
0.064 0004

’
5. Group names

Group names for cohort or prospective studies

Mame for first group [e.g.. Treated]

Mame for second group [e.g., Contral)

High
Standard

Binary outcome in cohort or prospective studies

Mame for events [e.g.. Dead]

Mame for non-events [e.q., Alive]

Cancel

Cannon
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There are two options at this point

e Enter the data directly into CMA
e Copy the data from Excel [Cannon.xls]

Here, we’ll show how to copy the data from Excel
e Switch to Excel and open the file

e Highlight the rows and columns as shown (Columns A to E only), and press CTRL-C to copy to
clipboard

E - = Cannon.xlsx - Excel
FILE HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW ACROBAT
Al - I Study name
A B c D E F G H I
1 |Study name High Event High N Standard Event Standard N
2 |Prove it 147 2099 172 2063
3 |AtoZ 205 2265 235 2232
4 |TNT 334 4995 418 5006
5 |Ideal 411 4439 463 4449
4]
7
8

e Switch to CMA

e Click in cell Study-name 1
e Press [CTRL-V] to paste the data Click here
e The screen should look like this

@ Comprehensive meta analysis - [Data]

File Edit Format View Insert Identify Too omputational options  Analyses Help
Run analyses —+ %\ D Dq' CX: ﬁ ﬁ — ’E 40.8 To‘%H w7 Jf _)+\/|:| %l El @

Study name /E%elar:s/ T;‘tlgth Séir;i‘?;d S_F.;?;::ar:]d Odds ratio Lofaﬁgds StdEm Wariance J K L ] M

1 High HighM  Standard  Standard M

2| Prove it 147 2093 172 2063 0.828 -0.183 017 0.014

3awZ 205 2265 238 2232 0.846 -0.168 01m 0.010

4| TNT 334 4395 418 5006 0.787 -0.240 0.076 0.008

5 Ideal 411 4439 463 4449 0.878 -0.130 0.071 0.005

[

7

8
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At this point we should check that the data has been copied correctly. Then

e C(Click anywhere in Row 1
e Select Edit > Delete row, and confirm

E‘ Comprehensive meta analysis - [Data]

Click here

File | Edit Format View Insert Identify Tools Computational options Analyses Help
Run: % Bookmark data | §| £ | ﬁ| QE| r— '=| '§| 3% b H - |7+ ¥ D| %i EH ®|
[ | 2 Re -
High Standard Standard . Log odds .
N RS ral N ‘ . ‘ Total N Odds ratio ratiol%d Err ‘ Warance J ‘ K. ‘ L ‘ b4 ‘ N ‘ u} ‘
1 h M Standard  Standard M |
2| =@ Copysdlection  Ctri+C [ 500 172 23|  oees| e anz ooig
3 Copy with header 2265 235 2232 0.845 0168 0101 0010
4 Copy entire grid 4955 418 BO0E 0787 -0.240 0.076 0.006
5 4433 463 4443 0.678 0130 0.071 0.005
5| @ Paste Ctrl+V
7R cut Ctrl+X
—g &7 Delete Del
10
1 Delete study
12 Delete column
13
14 Edit group names
| 15)
| 16
| 17
18

By default, the program is displaying the odds ratio as the effect size. We want to switch to the risk ratio

e Right-click on any of the yellow columns
e C(Click Customize computed effect size display

E‘ Comprehensive meta analysis - [Data]
File Edit Format View Insert Identify Tools Ceomputational options Analyses Help
Runanabses + % DS FH| &) 4 [B@ A= B9 -1 >+ [ 43U D
High High Standard | Standard . Log odds .
Study name Events TotalN ‘ Events ‘ Tatal M Odds ratio afio StdEn Wariance J ‘ K ‘ L ‘ ] ‘ M ‘ ]
1 Prove it 147 2099 172 2063 " P
A2 205 2265 235 2232 ;i ST
3 THT TR - 418 5006 £} sonz-a
4 |deal M 4439 463 4443 Colurnn properties
5
B Data entry assistant
7 3 Formulas
g
g Show all selected indices
10 ﬂ Show enly the primary index
1
BB ‘3 Setprimary index te Odds ratic
13 ﬂ Customize computed effect size dik_')lay
| 14
158
© www.Meta-Analysis.com Cannon — 99—
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e Tick Risk ratio
e Tick Log risk ratio

[ ]

e De-select Odds ratio

e De-select log odds ratio
e Click Ok

@ Comprehensive meta analysis - [Data]

Select Risk Ratio in the drop-down box in the wizard

File Edit Format View Insert Identify Tools Computational options Analyses Help
Runanayses + 2 2 FEHH (& & B@ E'-"="S 89~ 2>+ /] 4 3@
High High Standard | Standard . Logodds | . | | | | | "
Study nane Ewentz | TotalM Ewvents Total M Ddds ratic ratio l [ Effect size indices = | B || 3
1| Prove it 147 2093 172 2063 -0.183
2 A2 205 2285 23 2232 05848 40188 Use the following as the primary index
3| TNT 334 4395 418 5006 0787 -0.240
4 |deal M 4439 463 4443 0878 0130 |H'Sk ratia j
5
E Dizplay columnns for these indices
7
g [ Odds ratio -
q [ Log odds ratio T
10 [ Peto adds ratio
1 [ LogPeto odds ratio =
12 Risk ratio
13 Log risk ratio
14 [ Risk difference
15 [ Stddiff in means
[ Hedgessqg
18 [ Difference in means
17 [ StdPaired Difference
18 [ Corelation
13 [ Fisher'sZ
20 [J  Rate ratio
21 [ Lograte ratio
22 [J  Rate difference
23 ] Hazard ratio -
24 [¥ &lso show standard ermor
23 ¥ Also show variance
26
;; " Show the primary index only
9 " Show all selected indices
30
il Ok
32 Cancel
33
24 5
The program now display the risk ratio rather than the odds ratio
@ Comprehensive meta analysis - [Data]
File Edit Format View Insert Identify Tools Computation
rnnayses + % 0 o3 i | & 4| B @] - BE -V >+ v O 8@
High High Standard Stanflard . . Lag risk .
Study name Events Total N Events Tatd N Rigk ratio ratio Std Err Wariance L ]
1| Prove it 147 2039 172 063 0.840 0.174 0.108 0oz
2A02 205 2265 235 2dad IR==11) AL LT L0
3| THT 334 4995 418 500& 0.801 0.222 0.071 0.005
4| ldeal 411 4439 463 4443 0.890 0117 0.064 0.004
5
E
7
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Click File > Save As and save the file

Comprehensive meta analysis - [Data]

=
File Edit Format View Insert Identify Tools Computational options Analyses Help

0 New... 3

= QOpen Ctrl+ 0O

Opening screen wizard
Import

n Save Ctrl+S

& Print... Ctrl+P
D Print setup...

B3 s 2@ —=slaus - >+v[8 U
‘ iR ‘ Sl ‘ Stendatd | pigratio | 199K gwEn ‘ Vaiance J ‘ K ‘ L ‘ M ‘ N ‘ o
209 172 2063 0840|017 0.108 0.012
2265 25 P 0se0| DSt 0.091 0.008
439 418 5006 0.801 0222 0.071 0.005
43 463 4449 osam| 017 0.064 0.004

Exit

Note that the file name is now in the header.

e [Save] will over-write the prior version of this file without warning

e [Save As...] will allow you to save the file with a new name

E‘ Comprehensive meta an.

fysis - [C:\Users\Biostat\Dropbox\Workshops Three-Day\Cannon'cannon.cma]

"

File Edit Format View Ir

1

T

=

L ket

Run analyses =+ %z [ Din|§| %|.E|SE|

B v (L >+ v [ 8] 3 @)

Study name Eﬁfﬂl Tt.‘tlgth ‘ Séir;i?;d ‘ S_Fzg::agd Rizk ratio Lo[gtirLSk StdEn ‘ “ariance J ‘ K ‘ L ‘ i ‘ M ‘ u]
1 Prove it 147 2093 172 2063 0.540 0174 0108 nmz2
2402 205 2265 235 2232 0.860 0151 0.091 0.008
3 THNT 334 4395 418 5006 0.801 0222 0.071 0.005
4| ldeal 411 4439 463 4449 0.890 0117 0.064 0.004
5
E
7
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By convention we’ve put the treated group (High) in the first two columns and the control (Standard) in
the second two columns. Also by convention, we’ve defined “Event” as the presence of the outcome

(Dead).

When we follow these conventions, and the outcome is a bad event (as it is here) if the treated group

does better than the control, the risk ratio will be less than 1.

Therefore, in the present case, a risk ratio less than 1 indicates that High-Dose was associated with a

decreased risk of a coronary event.

It’s always a good idea to check at least one study and make sure that we have the direction right. For

this purpose we’ll use the third study (TNT).

@ Comprehensive meta analysis - [C:\Users\Biostat\Dropbox\Workshops Three-Day\Cannon'cannon.cma]

File Edit Format View Insert Identify Tools Computational options Analyses Help

rmanayses + % D S & 4 B@ E)—=E[ 8w Lo+ v 43 ®

Study name

1 Prove it
2 A2
3| TNT

4| Ideal

5

[
7

Both groups have approximately the same number of patients (about 5,000) but the number of events is
lower in the High-dose group than in the Standard-Dose group (334 vs. 418). The risk ratio is less than 1
(0.801), which means that patients treated with High-Dose were less likely to die.

High

High

Standard

Standard

Events Tatal M Events Tatal M Riisk ratia
147 2099 172 2063 0.840
205 22E8 238 2092 [LAE0

[ 334 4535 418 5006 0.801
M 4439 463 4449 0.890

e To run the analysis, click [Run analysis]

Log rigk
ratio

0174
-0.151
0222
0117

Std Enr

0108
0.091
0.071
0.064

a analysis - [C:\Users\Biostat\Dropbox\Workshops Three-Day\Cannon'cannon.cma]

Wariahce

0012
0.008
0.005
0.004

J K

File Edit Format Vi

Run analyses —+ %z

Insert Identify Tools Computational options Analyses Help

W EE & & @ E =S

D>+ 8@

Ty Name

1 Prove it
24z
3| TNT

4| ldeal

5

E
7

High
Ewvents
147
205
334
41

High
Tatal M
2099
2265
4335
4439

Standard
Events

172
235
418
463

© www.Meta-Analysis.com

Standard
Tatal M

2083
2232
5008
4443

= H
Rizk ratio Lo[gtinnsk StdEm
0.540 0174 0108
0.860 0151 0.091
0.801 0222 0.071
0.890 0117 0.064
Cannon

Wariance

nmz
0,005
0.005
0.004
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This is the basic analysis screen

Initially, the program displays the fixed-effect analysis. This is indicated by the tab at the bottom and

the label in the plot.

Comprehensive meta analysis - [Analysis] | o | E] [
File Edit Format View Computational options Analyses Help
+ Dala entry 3 Next table - High resolution plot | [gh Select by .. | =+ Effect measure: Risk ratio SECEETTIHE Xt @
Model Study name Statistics for each study Risk ratio and 95% CI ‘wieight [Fixed]
Risk ratio | Lower limit | Upper imit | Z%alue pWalue 0.50 1.00 2.00 Relative weight
Prove it 0840 0680 1.038 1615 0106 —_— 122zl
AtoZ 0.860 0713 1027 -1.666 0.036 I e— 1869 I
TNT [uk=ing] 0.E37 0520 3146 0.00z —_— 30,90 I
= 0830 074 1.003 -1.816 0.069 — 3719
Fized 0,843 0.786 0917 -4.164 0.000 ——
i ELL Both model:
Basic stats ne study removed Cumulative analysis Calculations

All four studies have risk ratios in the range of 0.80 to 0.90. Only one (TNT) is statistically significant. The
effects seem to be reasonably consistent. The confidence interval for every study overlaps the mean.

Click [Both models]

The program displays results for both the fixed-effect and the random-effects analysis.

Comprehensive meta analysis - [Analysis] | = | 5 e
File Edit Format View Computational options Analyses Help
4= Data entry t3 Next table :{— High resolution plot % Selectby ... | =+ Effect measure: Risk ratio - IE‘ D EE TT :{- E Jf T @
dadel Study name Statistics for each study Riisk ratio and 95% CI ‘wieight [Fixed] ‘wieight (R andom]
Risk ratio | Lower limit | Upper limit | Z4alue palue 0.50 1.00 200 Relative weight Rielative weight

Prove it 0.840 0.680 1.038 1615 0.106 —_— 1222l 1322
AtoZ 0.880 0719 1.027 -1.666 0.096 —_— 1269 1269 I
TNT 0em 0.EBa7 0920 3146 0.002 —_— 30,90 30.90 .
Lizal 0830 0.7a4 1.003 -1.816 0.063 — 3719 37.19 I

Fixed 0849 0.786 0917 -4.164 0.000 —

Random 0843 0.786 0917 -4.164 0.000 ——

Fixed | Randg

Basic stats Cumulative analysiz Calculations

Under the fixed-effect model the pooled effect size is 0.849 with a confidence interval of 0.786 to 0.917.
Under the random-effects model the pooled effect size is 0.849 with a confidence interval of 0.786 to

0.917.

© www.Meta-Analysis.com
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The fixed-effect model would be appropriate if all the studies were virtual replicates of each
other, which may or may not be the case here. The may have patients varied in some ways.

The random-effects model is appropriate because the studies may vary in ways that could
impact the effect size.

While the two models yield identical results, the random-effects model is a better fit for the way the
studies were sampled, and therefore that is the model we will use in the analysis.

e Click Random on the tab at the bottom

The plot now displays the random-effects analysis alone.

Comprehensive meta analysis - [Analysis]

[=E =

File Edit Fermat View Computational options Analyses Help

4 Data entry 3 Next table } High resolution plot % Select by ... | <+ Effect measure: Risk ratio = IE‘ D EE LT :{- E :E j @
tdodel Study name Statistics for each study Riizk ratio and 95% CI ‘wieight (R andom)
Rigk ratio | Lower limit | Upper limit | Z4alue palue 0.50 1.00 200 Rielative weight
Prove it 0.840 0680 1.038 -1E15 0106 —_— 132z
AtnZ 0.860 0713 1027 -1.666 0.096 —_— 1269 I
TNT [uk=iny] 0637 0920 3146 0.002 — 30,90 .
Ide 0.830 074 1.003 -1.818 0.089 — 37.19
Random 0849 0.786 0917 -4.164 0.000 ——

oth models

tudy removed

Cumulative analysis

Calculatiors

A quick view of the plot suggests the following

© www.Meta-Analysis.com

Most of the studies show an advantage for the high-dose group, but only one is statistically
significant
The observed effects are pretty consistent
The summary effect is 0.849 with a confidence interval of 0.786 to 0.917.
The summary effect has a Z-value —-4.164 a p-value of < 0.001. We reject the null hypotheses
that the true mean risk ratio is 1.0, and conclude that the risk of an event is lower in the high-

dose group.

Cannon
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Click [Next table]

Comprehensive meta analysis - [Analysis] | = | 5 e
File Edit Format ” options Analyses Help
4 Data entry 1 Next table :{— High resclution plot % Selectby ... | == Effect measure: Risk ratio - IE‘ D EE lT :{- E :E j @
dodel Study name Statistics for each study Riisk ratio and 95% CI ‘wieight (R andom)
Risk ratio | Lower limit | Upper limit | Z4alue palue 0.50 1.00 200 Relative weight
Prove it 0,840 0.680 1.038 -1.615 0106 —_— 1222
AZ (0.860 0719 1.027 -1.668 0.038 — 1269
TNT 0.8m 0637 n.8z20 3148 0.002 —_— 30,90
ldeal 0,850 0.784 1.009 -1.816 0.069 — 3719
R andom (0.843 0.786 0.917 -4.164 0.000 —
Both models
Basic stats | One study removed Cumulative analysis Calculations
Comprehensive meta analysis - [Analysis] =) B 3

File Edit Format View Computational options Analyses Help
+ Data entry 13 Next table - High resolution piot | [ Select by ... | < Effect measure: Risk ratio EICEETTHE E| 2 @
Model Effect size and 95% interval Test of null [2-Tail) Heterogeneity Tau-squared
Humber Point Lower Upper Tau Standard
Model Studies estimate limit limit Z-value P-value Q-value df () P-value |-squared Squared Error VYariance Tau
Fired 4 0843 0.786 0917 -4.164 0.000 1242 3 0743 0.000 0.000 0.005 0.000 0.000
Random 4 0.8439 0.796 0917 -4.164 0.000

The statistics at the left duplicate those we saw on the prior screen.

The summary effect is 0.849 with a confidence interval of 0.786 to 0.917.
The summary effect has a Z-value -4.164 a p-value of < 0.001. We reject the null hypotheses

that the true mean risk ratio is 1.0, and conclude that the risk of death is lower in the high-dose

The statistics at the upper right relate to the dispersion of effect sizes across studies. The Q-

value is 1.242 with df = 3. Q reflects the distance of each study from the mean effect (weighted,
squared, and summed over all studies). Q is always computed using FE weights (which is the
reason it is displayed on the “Fixed” row, but applies to both FE and RE analyses.

If all studies actually shared the same true effect size, the expected value of Q would be equal to

df (which is 3). Here, Q is less than this value, and so there is no evidence of variance in true

I? is the proportion of the observed variance that reflects differences in true effects rather than

sampling error. Since the variance in true effects is zero, I> must be zero.

T2 is the estimate of the between-study variance in true effects. Tis the estimate of the

between-study standard deviation in true effects. Since the variance in true effects is zero, both

[ ]
[ ]
group.
[ ]
[ ]
effects.
[ ]
[ ]
of these values must be zero. These value are both in log units.
e Click [Next table] to return to this screen

© www.Meta-Analysis.com
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Comprehensive meta analysis - [Analysis]

E=E <

File Edit Format View Computational options Analyses Help

4+ Data entry 4 Next table :{— High resolution plot | [Py Select by ... | 4~ Effect measure: Risk ratio © E‘ D EE ]_T :{- E F| i @
odel Study name Statistics for each study Rizk ratio and 95% CI ‘wieight (R andam]
Risk ratio | Lower limit | Upper imit | Z4alue palue 0580 1.00 2.00 Relative weight

Prove it 0.840 0.E80 1.038 -LE1S 0106 e 13220
AtoZ 0.860 0713 1.027 -1.666 0.036 — 18.63
TNT 0.8m 0637 0920 3146 0.0oz2 B — 30.90
Idzal 0.8a0 0.734 1.009 -1.81E 0.0849 — 37.19

R andom 0.849 0.786 0917 4164 0.000 —

Fived | Random | Both models

Basic stats One study removed Cumulative analysis Calculations

Click Hi-Resolution plot

Impact of Statin Dose on CV Events

Study name  Statistics for each study Risk ratio and 95% CI
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High dose vs. standard dose of statins
Overview

The analysis included four studies, each of which compared patients who were randomly assigned to
either a standard dose or a high dose of statins. The outcome was mortality or cardiovascular event, and
the effect size was the risk ratio. The results of this analysis will be generalized to comparable studies,
and so the random-effects model was employed for the analysis.

Is statin dose related to risk of a cardiovascular event?

The mean risk ratio is 0.849, which means that being assigned to a high dose rather than a standard dose
of statins resulted in a 15% lower risk of a cardiovascular event. The confidence interval for the risk ratio
is 0.786 to 0.917, which tells us that the mean risk ratio in the universe of comparable studies could fall
anywhere in this range. This range does not include a risk ratio of 1.0, which tells us that the mean risk
ratio is probably not 1.0. Similarly, the Z-value for testing the null hypothesis (that the mean risk ratio is
1.0) is -4.164, with a corresponding p-value of < 0.001. We can reject the null hypothesis that the risk of
a cardiovascular event is the same in both groups, and conclude that the risk is lower in the high-dose
group.

How much does the effect size vary across studies?

The Q-statistic provides a test of the null hypothesis that all studies in the analysis share a common effect
size. If all studies shared the same effect size, the expected value of Q would be equal to the degrees of
freedom (the number of studies minus 1). The Q-value is 1.242 with 3 degrees of freedom. Thus, the
observed dispersion is actually less than we would expect by chance. It follows that there is no evidence
that the true effect size varies from study to study. The /? statistic is 0%, which tells us that none of the
variance in observed effects reflects variance in true effects — all of it is due to sampling error. The
variance of true effects in log units (72) is 0.000, and the standard deviation of true effects in log units (7)
is 0.000 [G].

The between-study variance is estimated as zero. While this is probably an underestimate, since the
impact of this treatment almost certainly varies by population, we will assume that the variation in effects
is minor. If this assumption is correct, the impact of the treatment for all comparable populations falls
close to the mean effect size.
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